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IMPORTANT NOTICE 

All statements, technical information and recommendations in this document which relate to the 

products supplied by Meggitt Sensing Systems are based on information believed to be reliable, but 

unless otherwise expressly agreed in writing with Meggitt SA, the accuracy or completeness of such 

data is not guaranteed. Before using this product, you must evaluate it and determine if it is suitable 

for your intended application. Unless otherwise expressly agreed in writing with Meggitt SA, you 

assume all risks and liability associated with such use. Meggitt Sensing Systems takes no 

responsibility for any statements related to the product which are not contained in a current English 

language Meggitt Sensing Systems publication, nor for any statements contained in extracts, 

summaries, translations or any other documents not authored and produced by Meggitt Sensing 

Systems. 

 

 

 

EXPORT CONTROL 

The information contained in this document may be subject to export control regulations of the 

European Community, USA or other countries. Each recipient of this document is responsible for 

ensuring that the transfer or use of any information contained in this document complies with all 

relevant export control regulations. ECN N /A. 
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PREFACE 

 

About these release notes 

This document provides important information about the VibroSight ® software from Meggitt Sensing 

Systems. It is applicable to all VibroSight-based condition monitoring and machinery protection 

systems using the versions of software described by this document, namely: 

 VibroSight software version 2.11.1 (CD part number 609-004-000-021). 

Where VibroSight software version 2.11.1 is used in this document, it refers to VibroSight software 

version 2.11.1, unless otherwise stated. 

This document contains information about changes to the software since the previously released 

version (VibroSight 2.11.0), such as new features and improvements, solved problems and bug fixes, 

and hardware and software compatibility. 

For more general information on the actual software, or the entire condition monitoring system (CMS), 

refer to the following Meggitt Sensing Systems (MSS) documentation: 

 VibroSight software data sheet 

        (MSS document ref. 660-020-005-213A) 

 Getting started with VibroSight installation guide 

        (MSS document ref. 660-010-006-216A) 

 VibroSight help 

 XMV16 / XIO16T extended vibration monitoring card pair data sheet 

        (MSS document ref. 660-020-010-207A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in 

earlier versions of the software: 

 VibroSight 2.9.0 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.1 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.2 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.4 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.5 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.6 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.7 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.10.0 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.10.1 (MSS document ref. 660-010-013-201A) 

 VibroSight 2.11.0 (MSS document ref. 660-010-013-203A). 



     

 
 

   

     

 

     
 Release Notes VIBROSIGHT-RN/E (660-010-013-204A) 

Release 2.11.1 – February 2014 5 / 45  

     
 

Structure of the release notes 

This document presents information in the following order: general items first, then in terms of the 

software modules that constitute VibroSight, such as  Configurator,  Event Viewer,  Mimic, 

 Scope,  Server,  System Manager and  Vision. 

You should read those sections that are most relevant to you and then keep the document for future 

reference. 
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Version identifiers 

A complete VibroSight software product version number has four components x.x.x build x (or x.x.x.x) 

that provide the following information: 

 Major release identifier: x.x.x build x (or x.x.x.x) 

 Minor release identifier: x.x.x build x (or x.x.x.x) 

 Update identifier: x.x.x build x (or x.x.x.x) 

 Build identifier: x.x.x build x (or x.x.x.x) 

The version identifiers for installed software appear in the Help About box (obtained using 

Help > About … in any VibroSight software module). 

 

Terminology 

To distinguish between the different Meggitt Sensing System products that can be used with the 

VibroSight software, the following terminology is used in this document: 

 VM600 card – to refer to the VibroSight-software compatible cards that are installed in a VM600 

rack. The currently available VM600 cards that are designed for operation with the VibroSight 

software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T) and the CPUR card (for configuration only). 

Where XMx16 card is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T cards, unless otherwise stated. 
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1. Licensing 

In general, the licence key required to enable purchased product options remains unchanged between 

update level releases. For example, from version 2.11.0 to version 2.11.1. 

However, a new licence key is required for upgrades between major and minor version releases. 

For example, from version 2.10.x to version 2.11.x. 

To obtain a new VibroSight licence key file or for further information on licence keys, contact Meggitt 

Sensing Systems customer support. See section 7 Customer support. 

 

2. Features 

General 

2.1. VibroSight system operation without an NTP server 

VibroSight 2.11.1 now supports a new mode of operation that does not require a network time protocol 

(NTP) server as a time reference (that is, NTP-free) in order to supplement the existing mode of 

operation that does require an NTP server. This means that, starting with VibroSight 2.11.1, 

VibroSight systems can now be deployed in one of two ways: either without or with an NTP server. 

 

VibroSight systems without an NTP server (NTP-free): 

 Uses the local clock of the host computer running the VibroSight Server as the time reference. 

 Easy to deploy (reduced VibroSight system complexity and administrative burden). 

 Synchronization: 

o Data correlation ≤ 100 ms for data from the same VM600 XMx16 card 

o Data correlation ≤ 1 s for data from different VM600 XMx16 cards. 

 Recommended for the vast majority of machinery monitoring applications and should be used 

as the default mode of operation. 

 

VibroSight systems with an NTP server: 

 Uses an NTP server as the time reference (mandatory requirement). 

 Less easy to deploy (increased VibroSight system complexity and administrative burden). 

 Synchronization: 

o Data correlation < 100 ms for data from the same VM600 XMx16 card 

o Data correlation < 100 ms for data from different VM600 XMx16 cards. 

 Recommended for machinery monitoring applications requiring more accurate data 

synchronization. 
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NOTE: The highly configurable nature of the VibroSight software and VM600 XMx16 cards 

and the wide variation in machinery monitoring applications makes it impossible to 

define operating limits for VibroSight that are correct under all circumstances. 

In practice, the correlation of data from the same VM600 XMx16 card is usually 

better than 100 ms, depending on the data type and certain configuration settings. 

For example, the sample-by-sample correlation of waveforms that are acquired 

with similar configuration parameters (such as bandwidth, filtering and reference 

speed) is possible to 1 ms, while the sample-by-sample correlation of trends and 

dynamic data is possible to 100 ms. 

 

2.1.1. VibroSight 2.11.0 and earlier 

For VibroSight 2.11.0 and earlier, a VibroSight system required a network time protocol (NTP) server 

as a time reference. That is, VibroSight 2.11.0 and earlier implemented time based on absolute time 

for the communication between system components (VibroSight Server, VM600 XMx16 cards and so 

on). This makes the synchronisation of these components to a common time reference (NTP server) a 

mandatory requirement: 

 A VibroSight Server (process) uses an NTP server of sufficient quality as the time reference for 

its Server time, which is used to request and collate data from VM600 XMx16 cards and to 

timestamp the data received over external interfaces (such as Modbus and OPC). 

However, if the NTP server becomes unavailable, then the host computer clock is used as the 

fallback time reference for the VibroSight Server’s time. 

 VM600 XMx16 cards required an NTP server of sufficient quality as the time reference for their 

card times as each card timestamped their data locally using the card time, which was the 

absolute time in the VibroSight system. 

If all the cards in a system used and remained synchronized to the same NTP server 

(absolute time), then the data could be easily correlated. However, if the NTP server became 

unavailable, then the cards local time may drift apart. While the data acquisition on the card 

would continue the retrieval of data from those cards to the server would potentially be 

impacted. As a result of which, the VibroSight system could become effectively inoperative. 

NOTE: Cards would not start data acquisition until they had established communication with 

an NTP server of sufficient quality (NTP stratum). With a low quality or missing NTP server, 

the card would repeatedly cycle through its configuration and not start operation. 

 The VibroSight Server’s time was used to request and collate the data from the VM600 XMx16 

cards but the data was stored in the database using the data timestamps generated by the 

cards. (This allows for a certain transmission latency without losing correlatability of data once 

stored.) 

NOTE: VibroSight 2.11.0 systems required an NTP server for the VM600 XMx16 cards primarily, as 

the VibroSight Server could use the host computer clock as its time reference. 

Typically, where no external NTP reference could be guaranteed, a local ntp daemon running on the 

host computer such as Meinberg NTP for Windows was used for both server and cards, essentially 

running the System as an “island” that is synchronized within via NTP. 
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VibroSight 2.11.0 and earlier systems required sufficient synchronisation between VibroSight Servers 

and VM600 XMx16 cards in order to ensure that (i) a VibroSight Server’s request for data from a 

VM600 XMx16 card corresponded to data that was available from the card and (ii) data remained 

intact and correlateable for durations corresponding to VM600 XMx16 card buffer sizes. 

NOTE: In VibroSight 2.11.0 and earlier systems, a VibroSight Server and the VM600 XMx16 cards 

must have been configured to remain synchronous, which is usually achieved by using the same NTP 

server (time reference). 

Monitoring systems using VibroSight 2.11.0 and earlier were always deployed with an NTP server, 

typically in one of two ways: either (1) using Meinberg NTP for Windows or (2) using an NTP server 

available on the network. 

 

2.1.1.1. VibroSight 2.11.0 and earlier operating with an NTP server – using 
Meinberg NTP for Windows 

As shown in Figure 1, the host computer running the VibroSight software is also used to run the 

Meinberg NTP for Windows software, which allows the computer to act as an NTP server and provide 

the time reference required by the VM600 XMx16 cards (and optionally, the VibroSight Server). 

NOTE: Meinberg NTP for Windows is usually configured to use a forced quality (NTP stratum) but rely 

on the host computer clock as a fallback, making it independent of any external references. 

 

Figure 1: VibroSight 2.11.0 operating with an NTP server – using Meinberg NTP for Windows 
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Advantages 

No physical NTP server is required and the Meinberg NTP for Windows software is free to use. 

Easier to deploy from a network management perspective (no special requirements). 

 

Disadvantages 

Administrative burden to install the Meinberg NTP for Windows software (that is, the local NTP server) 

which includes creating system users and modifying the Windows Firewall (potentially opening ports). 

While the VibroSight system can stay synchronous with the host computer as the time reference, this 

may or may not be synchronised (that is, correlateable) with other on-site systems unless additional 

effort is deployed to achieve an “uplink” to this external source. 

A local NTP server may not be available 100% of the time, thereby putting the system at risk of losing 

synchronisation. 

 

 

2.1.1.2. VibroSight 2.11.0 and earlier operating with an NTP server – using an 
NTP server available on the network 

As shown in Figure 2, an NTP server is available on the network that is used by the VibroSight 

system, which provides the (absolute) time reference required by the VM600 XMx16 cards and the 

VibroSight Server. 
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Figure 2: VibroSight 2.11.0 operating with an NTP server – using an NTP server available on the 

network 

 

Advantages 

NOTE: The physical NTP server (“uplink”) provides a high-quality time reference, which in addition to 

keeping the VibroSight system components synchronised and ensuring continuous operation, allows 

the correlation of data with other on-site systems (based on their absolute timestamps). 

 

Disadvantages 

A physical NTP server is required (although, this is often available on the network). 

More difficult to deploy from a network management perspective, depending on the network 

infrastructure as there may be special requirements. For example, a separate VibroSight network, 

control network and applications network might require network changes in order to allow the 

VibroSight network to access the NTP server. 

If the NTP server becomes unavailable, the VM600 XMx16 cards no longer have the required NTP 

server and the VibroSight system may become inoperative: interruption to or permanent failure of the 

VibroSight Server to VM600 XMx16 card could result, leading to a potential loss of data. 
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If a host computer running a VibroSight Server becomes unavailable, only the VM600 XMx16 cards 

connected to that VibroSight Server become inoperative. Other VM600 XMx16 cards connected to 

other VibroSight Servers running on different host computers still have the NTP server and remain 

available. 

 

2.1.2. VibroSight 2.11.1 

Starting with VibroSight 2.11.1, an NTP server is no longer a mandatory requirement for a VibroSight 

system as two different modes of operation are now supported: 

 Without an NTP server (NTP-free) – suitable for the vast majority of machinery monitoring 

applications. 

 With an NTP server – suitable for machinery monitoring applications that require more accurate 

data synchronicity between VM600 XMx16 cards (≤100 milliseconds). 

 

To enable these different modes of operation, VibroSight 2.11.1 now implements time based on a 

combination of absolute time (for the VibroSight Server) and relative time (for the VM600 XMx16 

cards), thereby making an NTP server an optional requirement: 

 A VibroSight Server can use either the host computer clock or an NTP server as the time 

reference for its Server time, which is used to request and collate data from VM600 XMx16 

cards and to timestamp both the data from the cards and the data received over external 

interfaces (such as Modbus and OPC). 

However, an NTP server must be used as the time reference for the VibroSight Server in 

applications demanding more accurate data synchronicity. 

NOTE: If a VibroSight Server is configured to use an NTP server as its time reference and the 

NTP server becomes unavailable, the VibroSight Server will automatically switch to and use 

the host computer clock as the fallback time reference. 

 VM600 XMx16 cards no longer require an NTP server of a given quality as the time reference 

for their card times. Internally, each card continues to use the local clock as reference to 

acquire and to timestamp it locally as before. Each card’s local clock time is monitored by the 

VibroSight Server, which periodically polls each card in order to establish and maintain the 

time difference (delta) between the VibroSight Server a card. 

However, an NTP server must be used as the time reference for the cards in applications 

demanding more accurate data synchronicity. 

 The VibroSight Server’s time is used to request and collate the data from the VM600 XMx16 

cards. Since the VibroSight Server knows the deltas between itself and each card, it correlates 

the data from each card by correcting for the card’s specific delta (the delta to each card can 

be different) and the data is stored in the database using data timestamps that are calculated 

by the VibroSight Server using its Server time, each card’s time and the known deltas to each 

card. 

NOTE: All data (card and external interface) is stored in the database using timestamps generated by 

the VibroSight Server. 

In general, VibroSight 2.11.1 systems do not require the same level of synchronisation between 

VibroSight Servers and VM600 XMx16 cards (compared to VibroSight 2.11.0 and earlier systems) 

because a VibroSight Server constantly monitors the time differences between itself and its cards. 
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However, a VibroSight Server’s request for data from a VM600 XMx16 card must still correspond to 

data that is available from the card. 

Monitoring systems using VibroSight 2.11.1 are recommended to be deployed in one of the following 

two ways: either (3) without an NTP server or (4) using an NTP server. 

 

2.1.2.1. VibroSight 2.11.1 operating without an NTP server (NTP-free) 

As shown in Figure 3, no NTP server is required (NTP-free operation) as the clock of the host 

computer running the VibroSight software is used as the (absolute) time reference for the VibroSight 

Server and the (relative) independent time of each VM600 XMx16 card is monitored by the VibroSight 

Server. 

 

Figure 3: VibroSight 2.11.1 operating without an NTP server (NTP-free) 

 

In VibroSight 2.11.1, the VibroSight Server time is used to collate and timestamp all data from VM600 

XMx16 cards and external interfaces. 

An NTP-free VibroSight system is characterized by a data synchronicity: 

 ≤ 100 milliseconds between data correlated from the same VM600 XMx16 card. 

 ≤ 1 second between data correlated from different VM600 XMx16 cards. 
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Advantages 

No NTP server required. 

Easier to deploy from a network management perspective (no special requirements). 

Suitable for the vast majority of machinery monitoring applications. 

Less dependency and administrative burden. 

 

Disadvantages 

Not possible to guarantee data correlation from different VM600 XMx16 cards with a data-

synchronisation accuracy of less than 1 second. This fulfills the requirements of the vast majority of 

machinery monitoring applications that work with long-term historical trends. 

 

 

2.1.2.2. VibroSight 2.11.1 operating with an NTP server – using an NTP server 

As shown in Figure 4, an NTP server is required on the network that is used by the VibroSight system 

in order to provide a (absolute) time reference to be used by the VibroSight Server and the VM600 

XMx16 cards. As with NTP-free operation, VibroSight Server monitors the (relative) independent time 

of each card and applies the specific delta when collating data from the cards. 

NOTE: In VibroSight 2.11.1 systems that use an NTP server as a time reference, a VibroSight Server 

and the VM600 XMx16 cards must be configured to use the same NTP server. (As with VibroSight 

2.11.1 systems, the NTP server can be a physical NTP server or a locally running NTP server such as 

Meinberg NTP for Windows.) 
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Figure 4: VibroSight 2.11.1 operating with an NTP server – using an NTP server available on the 

network 

 

In VibroSight 2.11.1, the VibroSight Server time is used to collate and timestamp all data from VM600 

XMx16 cards and external interfaces. 

NOTE: The VibroSight system shown in Figure 4 looks the same as the VibroSight system shown in 

Figure 3 as the hardware (devices, network architecture and connections) is the same. However, as 

the VibroSight software and VM600 XMx16 card firmware are different, the VibroSight system 

operates differently: the timestamps for the data are calculated in a different way and the system is 

more robust to changes in the time reference. 

A VibroSight system using an NTP server as the time reference for a VibroSight Server is 

characterized by a data synchronicity: 

 ≤100 milliseconds between data correlated from the same VM600 XMx16 card. 

 ≤100 milliseconds between data correlated from different VM600 XMx16 cards. 

 

Advantages 

Possible to correlate data from different VM600 XMx16 cards in time with a data-synchronisation 

accuracy of less than 1 second, where required by machinery monitoring applications. 
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Disadvantages 

A physical NTP server is required (although, this is often available on the network). 

More difficult to deploy from a network management perspective, depending on the network 

infrastructure as there may be special requirements. For example, a separate VibroSight network, 

control network and applications network might require network changes in order to allow the 

VibroSight network to access the NTP server. 

 

NOTE: In a VibroSight monitoring system deployed for operation with an NTP server, if the 

NTP server becomes unavailable, the VibroSight Server will automatically default 

to NTP-free operation (by switching the time reference for its Server time from the 

NTP server to the host computer clock) and then gradually correcting (“drifting”) the 

current VibroSight Server time to the new time reference value. If this happens, the 

user is informed by messages in the VibroSight Server window and events in the 

VibroSight Event Viewer. This system event information is also recorded in the 

(technical) log files for the relevant VibroSight software module. 

 

2.1.3. Changes to the VibroSight software and XMx16 card firmware to support NTP-
free operation 

To support the NTP-free mode of operation that is recommended for the majority of VibroSight 

monitoring system applications, the VM600 XMx16 card firmware and VibroSight software were 

modified as follows: 

 VM600 XMx16 card firmware changed to implement time as an independent (relative) card time 

that is monitored and maintained by a VibroSight Server (relative to its own Server time), 

thereby eliminating the requirement for an NTP server for the cards. 

Also, cards no longer wait until they have established communication with an NTP server 

before starting data acquisition. 

 VibroSight Server software changed to implement time using a combination of absolute time (for 

the VibroSight Server) and relative time (for the VM600 XMx16 cards) and to collate, correlate 

and timestamp all data (card and external interface) using timestamps that are calculated by 

the VibroSight Server using its Server time, each card’s time and the known deltas to each 

card. 

As before, either the host computer clock or an NTP server can be used as the time reference 

for the VibroSight Server time. Using the host computer clock is suitable for the vast majority 

of applications, while using an NTP server provides more accurate data synchronicity between 

cards, if required. 

 

The VibroSight Server software was also modified for improved operation with time references: 

 The current VibroSight Server time (Server Time) and the time difference (delta) between the 

current Server time and the time reference (Delta to ref) are displayed in the status bar at the 

bottom of the VibroSight Server window. 

 Improved information concerning the time reference is displayed as messages in the VibroSight 

Server window, as events in the VibroSight Event Viewer and recorded in the technical log 



     

   
 

 

     

 

     
 20 / 45 Release Notes VIBROSIGHT-RN/E (660-010-013-204A) 

Release 2.11.1 – February 2014 
 

     
 

files (*.log and *.xlog) for the relevant VibroSight software module. 

In this way, the user is informed when there are changes to the time reference used by the 

VibroSight Server, such as switching between NTP-free operation and operation with an NTP 

server, when an NTP server being used becomes unavailable or as a result of (sudden) step 

changes to the time reference. 

 Improved behaviour of VibroSight Server in response to changes to the time reference. For 

example, when operating with an NTP server, a VibroSight Server will retry communications 

with an NTP server a number of times before deciding it is unavailable (so short interruptions 

are tolerated) and automatically switching to NTP-free operation. A VibroSight Server also 

reacts more consistently and reliably to step changes to the time reference, and when 

converging (fixed slope) to the time reference. 

 

The current VibroSight Server (Server Time) and the delta to the time reference (Delta to ref) 

displayed in the status bar at the bottom of the VibroSight Server window are colour-coded: 

 Black text – indicates that the VibroSight Server time is synchronized to the time reference. 

 Red text – indicates that the VibroSight Server time is not synchronized to the time reference. In 

this case, the Delta to ref should be seen to be slowly decreasing as the VibroSight Server 

time gradually converges to the time reference. 

 

Improved behaviour of VibroSight Server in response to changes to the time reference includes: 

 When operating with an NTP server, a VibroSight Server will retry communications with the NTP 

server a number of times (five) before deciding if it is unavailable and automatically switching 

to NTP-free operation. 

 When there is a (sudden) step-change in the time reference, the behaviour of the VibroSight 

Server depends on the size of the step-change: 

 If the change in the time reference is <1 day, the VibroSight Server will either speed up or slow 

down as necessary in order to gradually correct (“drift”) the current VibroSight Server time to 

the new time reference value. 

In this case, the messages displayed in the VibroSight Server window (and VibroSight Event 

Viewer and the log files) inform the user, including the estimated time required to drift the 

current VibroSight Server time to the new time reference value. 

 

NOTE: This gradual drift towards the time reference occurs at a slow rate in order to provide 

smooth and continuous system operation. For large corrections, the time required to reach a 

new time reference value can be long (for example, a factor of 20 times the required 

correction). 

 

In addition, the current VibroSight Server (Server Time) and the delta to the time reference 

(Delta to ref) are displayed in red text in the VibroSight Server window until the VibroSight 

Server reaches the new time reference value. 

 If the change in the time reference is >1 day, the VibroSight Server will switch the current 

VibroSight Server time to the new time reference value in one single step. 

In this case, the messages displayed in the VibroSight Server window (and VibroSight Event 
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Viewer and the log files) inform the user, including data loss warnings for overlapping time 

periods (for backward jumps). 

 

NOTE: In VibroSight Vision, no information is displayed in plot documents corresponding 

to a potential gap in measurement data as a result of changes to a VibroSight 

Servers time reference. VibroSight Server, VibroSight Event Viewer and/or their log 

files record must be consulted to obtain such information. 

 

When a VibroSight Server time is converging towards a new time, after a step-change to the time 

reference <1 day, the VibroSight Server timebase either accelerates or decelerates in order to run at a 

constant (fixed slope) rate and gradually converge to the time reference. In this way, the data capture 

and presentation by VibroSight remains continuous. 

 

NOTE: Messages displayed in the VibroSight Server window (and VibroSight Event Viewer 

and the log files) inform the user when: 

 A VibroSight Server timebase jumps forwards and gaps in data can be 

created. 

 A VibroSight Server timebase jumps backwards and overlaps in data can be 

created that conflict with existing data having the same nominal timestamp. 

 

 

2.1.4. Changes to the VibroSight 2.11.1 user interface to support NTP-free operation 

 

2.1.4.1. VibroSight System Manager 

There are changes to the VibroSight System Manager user interface related to the configuration of a 

VibroSight monitoring system. 

In VibroSight System Manager, the NTP Settings command under Configuration in the Actions 

window now displays: a Use NTP server option button, a NTP server text box and a Disabled option 

button. 

(In VibroSight 2.11.0 and earlier, only the NTP Server text box was displayed, as an NTP server was 

mandatory for all VM600 XMx16 cards in a VibroSight system.) 

 

To configure a VM600 XMx16 card for NTP-free operation (suitable for the vast majority of machinery 

monitoring applications): 

 Select the Disabled option button. 

The Disabled and Use NTP server option buttons are mutually exclusive, so Use NTP server 

is cleared and NTP server text box becomes unavailable (greyed out). 

 Click the Finish button to apply the changes to the VM600 XMx16 card. 



     

   
 

 

     

 

     
 22 / 45 Release Notes VIBROSIGHT-RN/E (660-010-013-204A) 

Release 2.11.1 – February 2014 
 

     
 

To configure a VM600 XMx16 card for operation with an NTP server (suitable for applications 

requiring more accurate data synchronisation): 

 Select the Use NTP server option button. 

The Use NTP server and Disabled option buttons are mutually exclusive, so Disabled is 

cleared and NTP server text box becomes available. 

 Enter the address of the NTP server in the NTP server text box, either as an IP address (dot-

decimal notation) or a uniform resource identifier (domain name).  

 Click the Finish button to apply the changes to the VM600 XMx16 card. 

 

NOTE:  When a VibroSight monitoring system is operating with an NTP server, the 

VM600 XMx16 cards and the VibroSight Server should be configured to 

use the same NTP server. 

 

2.1.4.2. VibroSight Server 

There are no changes to the VibroSight Server user interface related to the configuration of a 

VibroSight monitoring system. Although more messages are now displayed in order to inform the user 

of changes to VibroSight system operation related to the time reference. 

In VibroSight Server, the Tools > Options menu command displays the time reference configured for 

the server under Environment \ Reference Clock Configuration. 

 

To configure a VibroSight Server for NTP-free operation (suitable for the vast majority of machinery 

monitoring applications): 

 Clear the Enabled check box. 

The NTP Server text box becomes unavailable (greyed out). 

 Click the OK button to apply the changes to the VibroSight Server. 

 

To configure a VibroSight Server for operation with an NTP server (suitable for applications requiring 

more accurate data synchronisation): 

 Select the Enabled check box. 

The NTP Server text box becomes available. 

 Enter the address of the NTP server in the NTP Server text box, either as an IP address (dot-

decimal notation) or a uniform resource identifier (domain name). 

 Click the OK button to apply the changes to the VibroSight Server. 

 

NOTE:  When a VibroSight monitoring system is operating with an NTP server, the 

VM600 XMx16 cards and the VibroSight Server should be configured to 

use the same NTP server. 
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2.1.4.3. VibroSight Event Viewer 

There are no changes to the VibroSight Event Viewer user interface related to the operation of a 

VibroSight monitoring system. Although more events are now available in order to inform the user of 

changes to VibroSight system operation related to the time reference. 

In VibroSight Event Viewer, changes related to the time reference are displayed as System events. 

Like other system events, these can be displayed live or logged to a database for subsequent 

analysis. 

NOTE: It is highly recommended to log time-reference related events to a database in 

order to allow the integrity of the data stored in a database to be known. 

 

2.1.5. Implications for upgrading existing VibroSight 2.11.0 and earlier systems 

Currently deployed VibroSight monitoring systems (that is, configured for operation with an NTP 

server) are compatible with and can be upgraded to VibroSight 2.11.1 for in order to take advantage of 

other improvements to the VibroSight software, such as improved operation with time references, 

solved problems and bug fixes. 

 

2.1.6. Recommendations for VibroSight 2.11.1 systems 

VibroSight monitoring systems now support two different modes of operation: NTP-free or with an NTP 

server. 

 NTP-free operation is recommended for the vast majority of machinery monitoring applications 

that work with long-term historical trends (see Figure 3). 

 Operation with an NTP server is recommended for those machinery monitoring applications that 

require data synchronicity <100 milliseconds (see Figure 4). 

See also section 5.2.1 Firmware. 

 

 

2.2. Unit preferences – new physical quantities and units 

The default unit sets (Metric and Imperial) included in VibroSight have been updated to include new 

units related to the following physical quantities: conductivity, density, generic, heat rate, heat value by 

volume, heat value by mass, load gradient, mass concentration, mole fraction, power factor, pressure, 

volume concentration and volumetric flow rate. 

To view the unit preferences, click Tools > Unit Preferences on the menu bar in a VibroSight 

software module, such as VibroSight Configurator, VibroSight Scope or VibroSight Vision. 
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3. Solved problems and bug fixes 

General 

3.1. Improvements and bug fixes 

General stability improvements and multiple bug fixes across the various VibroSight 2.11.1 software 

modules. 

 

3.2. VibroSight Server to VibroSight software module communications after 
configuration changes 

After a configuration is changed and re-activated using VibroSight Configurator, the VibroSight Server 

automatically notifies all open VibroSight software modules (clients) with a connection to the Server of 

the changes to the configuration. This is necessary in order to ensure robust system operation. 

However, the notification mechanism did not always work correctly with the result that configuration 

changes were not propagated throughout a VibroSight system. In general, this was characterised by 

issues such as activation errors (for example, the “Error while notifying a subscriber about modification 

of the active configuration” message in VibroSight Server) and VibroSight software modules (clients) 

that stopped updating their data. This bug has been corrected. 

 

3.3. Tachometer ratios for order-tracked measurements 

When order-tracked measurements are used (Sampling Mode: Order Tracked), a tachometer input 

channel must be configured to provide the reference (Reference Speed) for the digital resampler. 

However, if this tachometer input channel is configured with a non-integer ratio (Pulses Per Rev.), 

then the associated order-tracked measurements (such as waveforms and spectrums) do not work 

correctly as they are displayed in frequency. This bug in the VM600 XMx16 card firmware has been 

corrected. 

 

 

 VibroSight Server 

3.4. VibroSight Server stops responding when unit preferences being accessed 

If unit preferences (unit sets) were being used by VibroSight software modules such as VibroSight 

Configurator, VibroSight Scope or VibroSight Vision at the same time that VibroSight Server tried to 

access unit preference files, an file access conflict (“unhandled exception”) could cause VibroSight 

Server to stop responding (crash). This bug has been corrected. 
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 VibroSight System Manager 

3.5. Database copy operations 

The behaviour of database copy operations appeared to be different depending on the options used 

and whether the command was run from VibroSight System Manager (Database Copy command) or 

from a command line (VibroSightDataCopy.exe). 

In fact, the database copy command always ignores the -t option (“use timestamp”) if the -odb 

option (“overwrite an existing database”) or -odsn option (“overwrite an existing DSN”) is also used by 

the command. 

In VibroSight System Manger, the Database Copy Wizard that is used when the Copy command is run 

displays Overwrite database file and Use timestamp as mutually exclusive check boxes, with a 

warning if the user tries to select both, so the underlying command cannot be run with -t and -odb or 

-odsn. 

However, using the equivalent command-line tool, there are no such restrictions, so the copy 

command can be run with -t and -odb and –odsn. (although the –t option will be ignored). 

To avoid confusion, the text displayed by the VibroSightDataCopy.exe -Help command and the 

VibroSight help have been updated with clearer explanations. In addition, if the copy command is run 

with -t and -odb or –odsn from a command-line, then a message is displayed to the user before the 

command is run: 

Parameters Warning: 

“The parameter –t will be ignored using the –odb or –odsn parameters.” 

 

3.6. Database purge operations 

Under certain circumstances, scheduled database purge operations using the command-line 

VibroSightDataPurge.exe command did not delete the configuration associated with the purged 

data (even though the purge data and the truncate and reset transaction log operations were e 

finished correctly) and reported “Error while deleting configuration”. This bug has been corrected. 
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4. Known issues 

4.1. Changing a VibroSight Server’s maximum RAM cache size when DSNs are 
not used 

Since VibroSight 2.9.7, a VibroSight Server database no longer requires a data source name (DSN), 

so it is no longer required to use the ODBC Data Source Administrator to manage the underlying 

connection to the Sybase SQL Anywhere 11 database (which provided convenient access to the start 

line command that is used to start the SQL Anywhere 11 server). 

NOTE: dbeng11.exe -ch 600m is the default command used to start the SQL 

Anywhere 11 server, where the -ch 600m option specifies that a maximum RAM 

cache size of 600 MB should be used. (This option limits the underlying SQL 

Anywhere’s database server cache during automatic cache growth.) 

However, for more complex machinery monitoring applications and larger 

databases, it is recommended that a maximum RAM cache size of 2000 MB 

(-ch 2000m) is used, in order to improve the overall performance of the VibroSight 

machinery monitoring system. 

 

When a DSN is not used with a VibroSight Server database, the settings usually written to the DSN 

using the ODBC Data Source Administrator are managed by the VibroSight Server itself and stored in 

the VibroSight Server configuration file (*.vssrvcfg). However, this means that the specification of 

the maximum cache size to be used by the VibroSight Server database is not as convenient to access 

by the user. 

Presently, the default command used to start the SQL Anywhere 11 server will be used unless: 

 In VibroSight Configurator, when saving the configuration as a server / database, the Configure 

advanced settings option is used to enter a different SQL database start line command. 

 In VibroSight System Manager, when copying the database, the Configure advanced settings 

option is used to enter a different SQL database start line command. 

So when DSNs are not used with a VibroSight Server database, the VibroSight Server configuration 

file (*.vssrvcfg) must be edited manually if it is necessary to change the SQL database start line 

command after a VibroSight Server database has been created or copied: 

1. Exit all VibroSight software modules (clients and servers) that use the VibroSight Server 

database to be modified. 

2. Use a text editor program to open the VibroSight Server configuration file (*.vssrvcfg) and 

search for the text string dbeng11.exe. 

3. Edit the StartLine="dbeng11.exe -ch 600m" command in the configuration file to use the 

new required maximum cache size. 

For example, StartLine="dbeng11.exe -ch 2000m", then save the file. 

4. Restart the VibroSight Server. 

 

If the StartLine="dbeng11.exe -ch 600m" command cannot be found in the VibroSight Server 

configuration file being used, then a “dummy” copy of the VibroSight Server database should be 
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created using VibroSight System Manager’s Database Copy command with the Configure advanced 

settings option selected. A “dummy” VibroSight Server configuration file created in this way will include 

the SQL database start line command and can be used as an example to edit the VibroSight Server 

configuration file being used. (After which, the “dummy” files should be deleted.) 

NOTE: It is highly recommended to make a backup copy of the VibroSight Server 

configuration file being used before manually editing it. 

Such manual edits must be done carefully in order to ensure that the tags and 

delimiters used in the VibroSight Server configuration file are used correctly. 

 

4.2. Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time 

or Local computer time and the site time or local computer time is subsequently changed on the 

relevant computer (for example, using Windows > Control Panel > Date and Time), this change is not 

reflected in the VibroSight Vision user interface until the user clicks on the Timestamp displayed in 

the VibroSight Vision status bar. 

 

4.3. Small “holes” in plotted data for large VibroSight Vision projects when 
viewing live data 

Depending on the complexity of a VibroSight application and the performance of the computer running 

the VibroSight software, the responsiveness of VibroSight Vision can decline under certain situations 

and affect the display of plots when viewing live data. 

In particular, this performance issue has been seen with large VibroSight Vision projects containing 

many open plots using live data. It is typically characterised by plots being displayed with small “holes” 

in the data, corresponding to when the computer has reached its performance limits. 

If this behaviour is seen, the recommended workaround is to: 

 Reduce the number of active plots in the VibroSight Vision project in order to reduce the 

computational load, as only the currently displayed (foreground) plots are constantly 

refreshed. Plots that are hidden or minimized (background) are not active and will only be 

refreshed when they become visible again. 

 If it is necessary to view historical data at the same time, consider using a separate VibroSight 

Vision session to work with the historical data, preferably on a different computer. 

 

4.4. Missing data for XMV16 and XMVS16 cards 

When the order-tracked sampling mode is being used, XMV16 and XMVS16 cards have been seen to 

disappear (drop out) and produce no data for periods of 10, 20 or 30 seconds. After which, the card 

usually reappears without any intervention and normal operation resumes. 

This issue is being investigated and appears to be a XMV16 and XMVS16 card firmware problem that 

is related to transitions in the input speed signal from “zero speed” to “non-zero speeds”. 
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4.5. VibroSight Server and Host Service restart required after changes to 
network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or 

disconnected) on a computer running VibroSight, then the VibroSight Servers and Host Services 

running on the computer must be restarted in order for the network adapter to be recognized by the 

VibroSight discovery mechanism. 

 

4.6. Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 

27 characters were allowed in previous versions. This constraint is enforced during the creation of new 

server instances with VibroSight 2.9.6 or later. 

However, existing server instances may be non-compliant (too long) and no longer run after an 

upgrade of the VibroSight software. In such cases, the server instance name should be manually 

edited in the VibroSight configuration file (*.vssrvcfg or *.config) to be 18 characters or less. 

Changes may also be required in any VibroSight software that references the server instance name, 

for example, associated VibroSight Vision Projects. 

For automated database copies that append a timestamp (_yyyyMMddHHmmss) to the Server 

instance name, the number that remain available for VibroSight Server instance names is deduced to 

3 characters. Alternatively, the server instance name can be shorted after the database copy is 

complete. 

 

4.7. VibroSight client connections to local and remote VibroSight Servers are 
mutually exclusive 

When a VibroSight Server is running on a (local) computer, a VibroSight client, such as VibroSight 

Configurator or VibroSight Vision running on the same (local) computer cannot connect to a VibroSight 

Server running on a different (remote) computer. 

 

4.8. VibroSight Servers listen to a single IP address 

VibroSight Servers use one specific IP address for connections to VibroSight clients. This IP address 

can be set to any of the available LAN adapters or logical addresses on the host computer, such that 

all traffic is directed through this address. However, this prevents concurrent connections from 

VibroSight clients running on other computers through different IP addresses. 

 

4.9. Gaps in logged Modbus data 

When data logging with pre-trigger is used (for example, a time-based data logging rule with 

Pre Logging selected) or database operations such as a database copy or a database purge 

command occur at the same time as standard data logging, gaps can appear in the Modbus data that 

has been logged at a standard rate. 
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These gaps in Modbus data are related to the computation of alarms when data is written to the 

database, which can be slow and can prevent some subsequent Modbus data from being handled 

correctly, especially when VibroSight Server is busy with other data intensive tasks. 

 

4.10. Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, 

UTC time or Local computer time, all other VibroSight client software modules continue to display 

timestamps in local computer time only (that is, the date and time according to the local clock of the 

computer running the VibroSight software module). 

 

4.11. Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always 

update correctly to show all of the devices (VM600 cards) available on the network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a 

refresh (using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

 Wait a few minutes and refresh again. 

 Restart VibroSight System Manager. 

 

4.11.1. VibroSight Mimic backwards compatibilty 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight 

Mimic client software module for mimics (that were previously available in VibroSight Vision). As a 

result, VibroSight Vision mimics created with VibroSight 2.9.7 or earlier are not compatible with 

VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client 

software module. As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are 

not compatible with VibroSight 2.11.0 or later. 

 

4.11.2. Changes to VibroSight configurations not being  

Changes made to a VibroSight configuration are not always visible in other VibroSight software client 

software modules (depending on the changes made). 

More specifically, if VibroSight client software modules are running (open) when changes to a 

configuration are saved and activated using VibroSight Configurator, the changes do not always 

become visible in the other VibroSight software modules. 

If this behaviour is seen, the recommended workaround is to restart the affected VibroSight software 

modules. Note: This issue does not affect VibroSight Servers.    
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5. Compatibility 

NOTE: Refer also to the latest version of the  Getting started with VibroSight 

installation guide or the  VibroSight software data sheet for further information 

on VibroSight’s prerequisites and compatibility. 

 

As part of the VibroSight software installation process, the installation wizard will automatically check 

to see if the “Microsoft Visual C++ Redistributable Package” (see section 5.1.4) and the “OPC Core 

Components Redistributable (x86)” (see section 5.1.5) are available on the computer. 

If these items have not previously been installed and they are required by the VibroSight installation’s 

application, then the VibroSight installation wizard can be used to install them. 

 

5.1. VibroSight software 

VibroSight 2.11.1 is an update version release in the 2.x.x series and replaces VibroSight 2.11.0. 

Compatibility with existing databases is achieved using the database  Update tool (from 

VibroSight System Manager’s  Database tools) which supports the continued used of 

configurations and data from previous versions. See section 6.1.1 Updating the internal structure of a 

VibroSight database. 

 

5.1.1. Microsoft Windows operating systems 

VibroSight 2.11.1 is compatible with 32-bit versions and 64-bit versions of Microsoft ® Windows ® 

operating systems. 

NOTE: Since VibroSight 2.9.0, VibroSight can run on 64-bit versions of Windows in order 

to help eliminate memory and performance issues that can occur due to the 

limitations of the 32-bit memory space. 

However, VibroSight 2.11.x remains 32-bit software that runs on x64 Windows in 

the same manner as it does on 32-bit windows, that is, VibroSight is "x64-

compatible" software (not "native x64" software). 

 

See the appendix of this document for detailed information on VibroSight software and Windows 

operating system compatibility. 
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5.1.2. Microsoft .NET Framework 

For most Windows operating systems, VibroSight 2.11.1 requires that the Microsoft .NET Framework 

4.5 is installed on the computer.  

NOTE: Microsoft .NET Framework 4.5 is required since VibroSight 2.9.4. 

Microsoft .NET Framework 4 (Standalone Installer) is required for VibroSight 2.9.2 

and 2.9.3. 

Microsoft .NET Framework 3.5 SP1 is required for VibroSight 2.9.1 or earlier. 

 

See the appendix of this document for detailed information on VibroSight software’s Microsoft .NET 

Framework requirements. 

 

5.1.3. Sybase SQL Anywhere 11 software 

VibroSight uses the Sybase ® SQL Anywhere 11 database software in its standard configuration. 

VibroSight 2.11.1 remains compatible with the previously deployed version of SQL Anywhere, namely 

SQL Anywhere version 11.0.1.2044. 

NOTE: VibroSight requires the 32-bit version of SQL Anywhere 11 on both 32-bit and 64-

bit Windows operating systems. 

It is strongly recommended that only the 32-bit version of SQL Anywhere 11 is 

installed on the computer running VibroSight. 

 

NOTE: Updating SQL Anywhere to version 11.0.1.2867 is mandatory in order to avoid 

potential memory issues (fixed by Sybase). A software update (patch) included on 

the Sybase CD must be run in order to update Sybase SQL Anywhere from version 

11.0.1 to version 11.0.1.2867: SA11_Full_Win32+x64.1101_2867_EBF.exe. See 

section 6.2 Upgrading the Sybase SQL Anywhere 11 software. 
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5.1.4. Microsoft Visual C++ Redistributable Package 

The Microsoft Visual C++ Redistributable Package is required in order to install and register the Visual 

C++ libraries required by a VibroSight OPC server. 

If this package does not already exist on the computer, then the VibroSight installation wizard will 

install it automatically. (The package is included in the ISSetupPrerequisites folder on the 

VibroSight CD.) 

NOTE: The Microsoft Visual C++ Redistributable Package is required since 

VibroSight 2.9.4, if VibroSight OPC servers are being used. 

The 32-bit version of the package (“vcredist_x86.exe”) is installed on both 32-bit 

and 64-bit Windows operating systems, as the VibroSight OPC server is a 32-bit 

application. 

 

5.1.5. OPC Foundation OPC Core Components Redistributable 

The OPC Core Components Redistributable is required in order to configure and run VibroSight OPC 

clients and OPC servers correctly: the redistributable must be installed on OPC client computers in 

order to allow connections to remote OPC servers and it must be installed on OPC server computers 

in order to allow OPC clients to browse for running OPC servers. 

If this redistributable does not already exist on the computer, then the VibroSight installation wizard 

will install it automatically. (The redistributable is included in the ISSetupPrerequisites folder on the 

VibroSight CD.) 

NOTE: The OPC Core Components Redistributable is required since VibroSight 2.9.4, if 

OPC clients or OPC servers are being used. 

The 32-bit version of the package (“OPC Core Components Redistributable (x86)”) 

is installed on 32-bit Windows operating systems and the 64-bit version of the 

package (“OPC Core Components Redistributable (x64)”) is installed on 64-bit 

Windows operating systems. 

 

 

5.2. VM600 cards 

5.2.1. Firmware 

There are firmware updates for some VM600 cards corresponding to VibroSight 2.11.1. 

The latest firmware for the CPUR card remains: 

 Applications:  applications-640-012-001-003.tgz 

 Base System: base-system-640-011-001-003.tgz. 
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The latest firmware for the XMC16, XMV16 and XMVS16 cards is now: 

 Applications:  applications-640-010-001-009.tgz 

 Base System: base-system-640-003-001-010.tgz. 

Therefore, for current versions of the VibroSight-compatible VM600 cards, firmware upgrades are 

required. See section 6.3 Updating the VibroSight hardware. 

Improvements to this latest XMx16 card firmware includes support for the operation of a VibroSight 

system without an NTP server (see 2.1 VibroSight system operation without an NTP server) and a bug 

fix for order-tracked measurements with non-integer tachometer ratios (see 3.3 Tachometer ratios for 

order-tracked measurements). 
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6. Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. 

Perform the steps in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 

hardware (XMx16 cards) before starting a VibroSight system upgrade, in order to 

establish if any firmware updates are also required. See section 6.3.2 Updating the 

firmware using VibroSight System Manager. 

 

 

6.1. Upgrading the VibroSight software 

NOTE: Since VibroSight 2.9.6, VibroSight Server instance names are limited to 

18 characters (previously, it was 27). So VibroSight installations with VibroSight 

Server instance names of more than 18 characters will experience problems with 

VibroSight 2.11.x until the existing VibroSight Server instance names (and any 

references to them) are manually edited to be 18 characters or less. See 

section 4.6 Length limitation of VibroSight Server instance names. 

 

1. If it is not necessary for the VibroSight-based system to remain operational during the upgrade 

procedure, back up any important (required) VibroSight databases in the following way: 

 Exit all VibroSight software modules (clients and servers) – no VibroSight software modules, 

such as Vision, Configurator or Server, should be running. 

 Copy the files (*.vssrvdb, *.vssrvcfg and optionally, *.log) from the directory 

where your database files are located to another location, for example, to a specific backup 

directory. 

 NOTE: The default data (data path) directory is C:\VibroSight Data 

Or if it is necessary for the VibroSight-based system to remain operational for as long as 

possible during the upgrade procedure, back up any important (required) VibroSight databases 

in the following way: 

 Exit all VibroSight software modules (clients) – no VibroSight software modules, such as 

Vision or Configurator, should be running. 

 Start VibroSight System Manager and use the database  Backup tool from VibroSight 

System Manager’s  Database tools, and follow the instructions presented by the 

Database Backup Wizard. 
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 NOTE: It is necessary to be logged in to System Manager as ‘Admin’ in order to have the 

user rights to access the database tools: 

Select your  VibroSight Host (computer) in the System Explorer tree structure 

and click  Login (from VibroSight System Manager’s  Access Rights 

tools). 

Refer also to the Backing up a database topic in the  VibroSight help. 

 

2. Make backup copies of any important (required) VibroSight Vision projects in the following way: 

 Create an archive file (for example, *.zip) containing all of the files (*.xml and 

*.xmsproj) in the directory where your project files are located. 

 NOTE: The default project directory is: 

C:\Documents and settings\username\My Documents 

\VibroSight\Projects 

 

3.  Ensure that no VibroSight software modules are running. 

4. Remove the currently installed version of the VibroSight software (for example,  

 VibroSight Standard Edition) using Windows Add or Remove Programs, in one of the 

following ways: 

 Click Start > Settings > Control Panel and then double-click Add or Remove Programs. 

 Or click Start, click Control Panel and then double-click Add or Remove Programs. 

5. Install the latest version of the VibroSight software by inserting the VibroSight CD into the 

CD/DVD drive of the computer and follow the instructions presented by the VibroSight 

installation wizard. 

NOTE: Refer to the  Getting started with VibroSight installation guide for detailed 

information on installing the VibroSight software – including prerequisites and 

compatibility. 

 

6. Restart VibroSight Server and ensure that the required communications are enabled. For 

example, enable card and module device drivers according to the hardware in the system: 

 For example, click Data > Acquisition > XMC16/XMV16 Card Driver. 

7. Restart VibroSight Vision and ensure that live data is being received from the hardware and 

displayed in Vision. 

8. The VibroSight system is now up and running. 
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6.1.1. Updating the internal structure of a VibroSight database 

When VibroSight Server is started, it checks the status of the database and will automatically inform 

the user if any internal structures of the database need to be updated before proceeding. 

1. Update a VibroSight database in the following way: 

 Start VibroSight System Manager and use the database  Update tool from VibroSight 

System Manager’s  Database tools, and follow the instructions presented by the 

Database Update Wizard. 

 NOTE: It is necessary to be logged in to System Manager as ‘Admin’ in order to have the 

user rights to access the database tools: 

Select your  VibroSight Host (computer) in the System Explorer tree structure 

and click  Login (from VibroSight System Manager’s  Access Rights 

tools). 

Refer also to the Updating a database topic in the  VibroSight help. 

 

 

6.2. Upgrading the Sybase SQL Anywhere 11 software 

VibroSight software is compatible (and extensively tested) with Sybase SQL Anywhere versions 

11.0.0 and 11.0.1. 

However, with the release of SQL Anywhere version 11.0.1.2867, Sybase has fixed some previously 

known memory issues. Therefore, it is mandatory to upgrade all VibroSight systems to this version of 

SQL Anywhere 11. 

 

Determine the version of the SQL Anywhere 11 database engine installed on a computer in the 

following way: 

1. From the Start menu, click Start > All Programs > SQL Anywhere 11 > Sybase Central. 

The Sybase Central window appears. Sybase Central is a GUI-based management tool for 

Sybase products. 

2. Click Help > About Sybase Central. 

The About Sybase Central windows appears, displaying the version information for SQL 

Anywhere 11 (and any other installed Sybase products). 

 

 NOTE: Refer also to the Determining the version of SQL Anywhere 11 installed on a 

computer topic in the  VibroSight help. 
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If SQL Anywhere 11 version 11.0.0 is installed on the computer, it is necessary to first remove 

version 11.0.0, then install version 11.0.1 from the Sybase CD. 

If SQL Anywhere 11 version 11.0.1 is installed on the computer, simply update to version 11.0.1.2867 

by running the software update (patch) included on the Sybase CD. 

When SQL Anywhere 11 software version 11.0.0 is installed on the computer: 

NOTE: Do not use the SQL Anywhere 11.0.1 setup to upgrade directly to software version 

11.0.1 from software version 11.0.0. Instead, it is necessary to upgrade the Sybase 

database software as follows: 

1. Remove SQL Anywhere 11.0.0, using the Windows Add or Remove Programs 

tool. 

2. Install SQL Anywhere 11.0.1, using the Sybase SQL Anywhere 11.0.1 CD. 

Refer also to the  Getting started with VibroSight installation guide for 

information on installing the Sybase software. 

 

1. Exit all VibroSight software modules (clients and servers) – no VibroSight software modules, 

such as Vision, Configurator or Server, should be running – as this also stops the SQL 

Anywhere 11 database engine. 

The  lightning icon that appears in the notification area (at the far right of the task bar) to 

indicate that a Sybase database engine is running should no longer be shown. 

2. Remove the currently installed version of Sybase SQL Anywhere 11 using Windows Add or 

Remove Programs, in one of the following ways: 

 Click Start > Settings > Control Panel, then double-click Add or Remove Programs 

 Or click Start, click Control Panel and then double-click Add or Remove Programs. 

And remove  SQL Anywhere 11. 

3. Restart the computer. 

4. Install Sybase SQL Anywhere VibroSight 11.0.1.2044 by inserting the Sybase CD into the 

CD/DVD drive of the computer and following the instructions presented by the 

SQL Anywhere 11 installation wizard. 

5. Restart the computer. 

Without this final computer restart, VibroSight Server may not be able to start the 

SQL Anywhere 11 database engine. 
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When SQL Anywhere 11 software version 11.0.1 is installed on the computer: 

1. Update to Sybase SQL Anywhere VibroSight 11.0.1.2867 by inserting the Sybase CD into the 

CD/DVD drive of the computer, running the SA11_Full_Win32+x64.1101_2867_EBF.exe 

software update (patch) and following the instructions presented by the SQL Anywhere 11 

installation wizard. 

2. Restart the computer. 

 

 

6.3. Updating the VibroSight hardware 

Appropriate files and tools are included in the installation package to allow VM600 cards (CPUR and 

XMx16) to be updated to the latest firmware, in order to take advantage of improvements to the 

VibroSight software. 

Updating the firmware VM600 cards is a special task that can, if used unintentionally or incorrectly, 

lead to malfunctioning of the device and affect proper function of data acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal 

machinery monitoring functions because its outputs (alarms and relays) can go to undetermined 

states, irrespective of how they have been configured. 

NOTE: It is highly recommended that firmware updates are only performed in accordance 

with the operating procedures for the machinery being monitored and that 

appropriate precautions are taken at the control system level (such as DCS 

or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 

order to avoid false trips of the machinery being monitored. 

 

6.3.1. VM600 card firmware 

The latest VM600 card firmware files are copied to a directory on your computer as part of the 

VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600 cards is: 

C:\Program Files\Meggitt\VibroSight 2\Firmware\VM600 

 

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their 

.tgz file name extension. For example, the XMV16 subfolder contains the applications and base 

system firmware for use by XMV16 cards. Any additional firmware updates received from Meggitt 

Sensing Systems should also be stored in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that 

is, XMC16, XMV16 and XMVS16 card pair firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 XMx16 

card firmware that is compatible with the version of VibroSight software being used. 
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Table 1: VibroSight software and VM600 XMx16 card firmware compatibility 

 VM600 XMx16 card firmware 

VibroSight 

software version 

CD part number 

Base-system (*.tgz) 

640-003- 

001-004 

640-003- 

001-005 

640-003- 

001-006 

640-003- 

001-007 

640-003- 

001-008 

640-003- 

001-009 

640-003- 

001-010 

Applications (*.tgz) 

640-010- 

001-003 

640-010- 

001-004 

640-010- 

001-005 

640-010- 

001-006 

640-010- 

001-007 

640-010- 

001-008 

640-010- 

001-009 

2.8.0 

609-004-000-007 

 
      

2.9.0 

609-004-000-010 
       

2.9.1 

609-004-000-011 
       

2.9.2 

609-004-000-012 
       

2.9.3 

609-004-000-013 
       

2.9.4 

609-004-000-014 
       

2.9.5 

609-004-000-015 
       

2.9.6 

609-004-000-016 
       

2.9.7 

609-004-000-017 
    

See note 1
   

2.10.0 

609-004-000-018 
    

See note 1
   

2.10.1 

609-004-000-019 
    

See note 1
   

2.11.0 

609-004-000-020 
    

See note 1
 
See 

notes 1 and 2 
 

2.11.1 

609-004-000-021 
      

See note 3
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Notes for Table 1 

1. Updating to these versions of VM600 XMx16 card firmware requires a two step process: (i) VibroSight System Manager’s 

Change Firmware command should be used to update the base-system firmware (640-003-001-00*.tgz) only, then (ii) the 

Change Firmware command should be used again to update the applications firmware (640-010-001-00*.tgz) only. 

2. This version of VM600 XMx16 card firmware introduces support for the direct measurement mode that is used to acquire 

direct data (digitised waveform) before an event. 

3. This version of VM600 XMx16 card firmware introduces support for the operation of a VibroSight system without an NTP 

server (NTP-free). 
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6.3.2. Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade 

the firmware of VM600 XMx16 cards to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600 card firmware update may lead to 

incoherent system behaviour and affect the proper functioning of data acquisition in a system. It is only 

in systems where the firmware running on the XMx16 cards already corresponds to the latest available 

version that no firmware update is required. Therefore, it is strongly recommended to verify the version 

of firmware running on the hardware before starting a VibroSight system upgrade, in order to establish 

if a firmware update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 

that can – if performed unintentionally – affect the proper functioning of data 

acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 

hardware only when it is necessary. For example, when the devices must be 

updated to be compatible with a VibroSight software upgrade. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight 

System Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the 

hardware (XMx16 card) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System 

Explorer window. 

The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the 

network. If there are no XMx16 cards in the tree structure or some cards are missing, verify your 

network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the 

device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 

corresponding to the VibroSight-compatible VM600 card selected. 

.tgz files are for VM600 cards. 

 

6. Click the Finish button to start the firmware upgrade process. 
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For XMx16 cards, the firmware upgrade process can take up to 5 minutes, during which: 

 The IP address beside the device’s serial number in the Devices tree structure can 

disappear. 

 The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 

independently of the VibroSight software (once the process has started), firmware 

updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of 

firmware. It is therefore possible to change a device’s firmware to any previously available version, as 

well as the latest update. 

This feature can be useful in certain situations, for example, swapping spare VibroSight hardware 

between different VM600 racks, where systems are operating with different versions of VibroSight. 

 

6.4. Final checks 

After upgrading the VibroSight software, the following checks are recommended to ensure that 

VibroSight has not been inadvertently modified and that it continues to operate as expected: 

 Use VibroSight Configurator to run a consistency check on the configuration in order to ensure 

that the configuration has not been modified by any changes to the VibroSight software, 

internal database structure and firmware for the hardware (VM600 cards). 

 Use the VibroSight Server window to check that the data acquisition, data post-processing and 

data logging settings are as expected. (Click Data > Acquisition, Data > Post-processing 

and Data > Logging and disable/enable the drivers, processing managers and logging as 

required.) 
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7. Customer support 

7.1. Contacting us 

Meggitt Sensing Systems worldwide customer support network offers a range of support including 

Technical support and Sales and repairs support. For customer support, please contact your local 

Meggitt Sensing Systems representative. Alternatively, contact our main office: 

Customer support 

Meggitt SA 

Route de Moncor 4 

PO Box 1616 

CH-1701 Fribourg 

Switzerland 

 

Telephone: +41 (0) 26 407 11 11 

Email: energysupport@ch.meggitt.com 

Web: www.meggittsensingsystems.com 

 

7.2. Technical support 

Meggitt Sensing Systems technical support team provide both pre-sales and post-sales technical 

support, including: 

 General advice 

 Technical advice 

 Troubleshooting 

 Site visits. 

 

7.3. Sales and repairs support 

Meggitt Sensing Systems sales team provide both pre-sales and post-sales support, including advice 

on: 

 New products 

 Spare parts 

 Repairs. 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensingsystems.com/
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VibroSight software and Windows operating system compatibility 

 
Windows XP and 

Windows Server 2003 R2 

Windows Vista and 

Windows Server 2008 

Windows 7 and 

Windows Server 2008 R2 

Windows 8 and 

Windows Server 2012 

VibroSight software 

compatible? 

Yes, but not recommended for 

new installations as Microsoft 

support for Windows XP SP3 

ends on 08 April 2014 

Yes, but not recommended. 

Windows Server 2008 R8 

should be used instead of 

Windows Server 2008 

Yes – recommended for new 

installations 
To be announced 

 

Microsoft .NET Framework versions pre-installed on Windows operating systems 

 
Windows XP and 

Windows Server 2003 R2 

Windows Vista and 

Windows Server 2008 

Windows 7 and 

Windows Server 2008 R2 

Windows 8 and 

Windows Server 2012 

Microsoft .NET Framework 

pre-installed on Windows 

operating system 

None on XP. 

.NET Framework 2.0 on 

Server 2003 R2 

.NET Framework 3.0 .NET Framework 3.0 SP1 .NET Framework 4.5 

 

VibroSight software’s Microsoft .NET Framework requirements 

VibroSight software version 
Windows XP and 

Windows Server 2003 R2 

Windows Vista and 

Windows Server 2008 

Windows 7 and 

Windows Server 2008 R2 

Windows 8 and 

Windows Server 2012 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 .NET Framework 3.5 SP1 .NET Framework 3.5 SP1 .NET Framework 3.5 SP1 

VibroSight 2.9.2 and 2.9.3 .NET Framework 4 .NET Framework 4 .NET Framework 4 .NET Framework 4 

VibroSight 2.9.4 or later .NET Framework 4
 1
 .NET Framework 4.5 .NET Framework 4.5 .NET Framework 4.5 

 


